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Overview 

As of early 2015, Google Earth Pro, which used to be a $400 product, is now free. This is a 
simple yet powerful tool for viewing information geographically—whether it is for viewing climate 
information, analyzing change over time, or tracing routes from your vacation. In this tutorial, you 
will learn how to create placemarks (points of interest), analyze elevation changes over the  
landscape, import images and shapefiles, utilize the built-in library (3D buildings, weather, photo 
gallery, etc.), view historical imagery, navigate to a city with the directions module, geocode 
addresses, and create a route. 

Getting Started 

Once you open Google Earth Pro, you will be taken to the default screen. Take a moment to 
become familiar with the different parts of Google Earth Pro. If you look on the top left of the  
page, the sidebar contains a few different modules. 

 
➢ Search module which can be used to search for locations by using various methods, such as 

latitude/longitude, cities, provinces/states, nations, administrative boundaries, and 
addresses. To clear search results, click on ‘X’ on the bottom right of the Search module as 
indicated in the blue box (Figure 1). 

➢ In the middle is the Places module where locational information gets saved and 
organized as indicated in the red box (Figure 1). 

➢ At the bottom is the Layers module, which contains a variety of information, or layers, 
created by the Google Earth community that can be checked on and off for viewing 
purposes. Examples of these layers include photos, weather, labels, demographics (US 
only), and 3D buildings as indicated in the green box (Figure 1).  

➢ The toolbar at the top of the Google Earth interface gives access to a variety of features 
provided within Google Earth, including Place marks, creating polygons, image overlays, 
historical imagery, and so forth as indicated in the yellow box (Figure 1). 
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➢ The bottom of the screen provides helpful information such as the current coordinates for 
latitude and longitude and elevation of where your cursor is pointing. Off to the right you  
can also find the Eye altitude, or the altitude of which the Google Earth is currently viewing 
the world from as indicated in the purple box (Figure 1). 

 

Note: Remember to constantly save your project when you work on this tutorial to avoid losing 
your work progress if Google Earth window or your computer suddenly shuts down. To save a 
project click File on the top left of the window and then select Save -> Save Place As… (Figure 1) 
Once you select it, a pop-up window will appear. Then you browse to a folder that you want to 
save your project at. After you determine the location for storing your project and enter the name 
of the project in File name box, click Save. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1 Figure 2 
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Navigational Tips 

Google Earth has numerous methods of navigating physical space on your screen, including 

non-mouse controllers such as keyboards, touchpads, and joysticks. Depending on your device,  

the methods may vary slightly from one to another. The two most common platforms, however,  

are Macs and PCs. 
 

Command Windows 
Keystroke(s) 

Mac Keystroke(s) Result 

Linear 
movement 

Left, right, up, or down 
arrow 

Left, right, up, or down arrow Moves the viewer in the 
direction of the arrow. 

Rotate 
(perimeter) 

Shift + left, right, up, or 
down arrow 

Shift + left, right, up, or down 
arrow 

Rotates the view around 
the map’s perimeter. 

Rotate 
(on-the-spot) 

Ctrl + left, right, up, or 
down arrow 

+ left, right, up, or down 
arrow 

Rotates the view from 
the current position. 

Tilt Shift + up or down arrow + up or down arrow Tilts the viewer to/from 
“horizon” or “top-down” 

Look Ctrl + left mouse button + 
drag 

+ mouse button + drag View changes to mimic 
head movement. 

Stop current 
motion 

Spacebar Spacebar Stops movement when 
viewer is in motion. 

Return to 
“North-up” 
view 

N N Rotates view back to 
North-up. 

Return to “Top- 
down” view 

U U Resets tilt to “top-down” 
or Up mode. 

Reset tilt and 
compass view 

R R Resets tilt and rotation to 
default positions. 

Show/hide 
Overview 

Ctrl + M Shift + Option (Alt) + + M Displays or closes 
overview window. 

Tip: When rotating the view (perimeter or on-the-spot), use the up or down arrow to fluidly tilt the view 
while rotating. 

Tip: Use the Alt key together with most of these keystrokes to slow down the motion of your desired 
movement. 
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Learning Objective 

For this tutorial, you will be creating a walking tour of the surrounding area of the  Empire 

State Building in New York City. You will learn how to create Place marks (points of interest) with 

descriptions and supplemental information both by hand and geocoding and then to create a 

route connecting all your Place marks. You will also learn how to automate this tour with a video 

recording of your animated map, as well as adding ESRI shape files to enhance your end product. 

 
The first step in working with Google Earth will be to choose a location to work in. For 

this guide, we will use Madison Square Park. Before getting started, you will need to create your 

own folder. To do so click on Add -> Folder (Figure 3), enter folder name as “My Tour” and click 

OK (Figure 4). This will come in handy later when you are doing multiple steps. In the Search box, 

type in Madison Square Park and select the “Madison Square Park, Madison Avenue, New York, 

NY, USA” option. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3 
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Step 1: Historical Imagery 

First, we will look at Historical Imagery for this location. The Historical Imagery can be a 

very useful tool when utilized in the right circumstance. It enables the user to analyze change in  

the landscape overtime. For example, we can use the historical imagery to view the changes of  

Times Square over the years. 

After searching ‘Madison Park Square’, select the Show historical imagery button in the 

upper middle area of the screen just above the map as seen in Figure 5. 

 
A scroll bar will appear on the top left of your screen in the map window. Use it to scroll  

through imagery from different dates. You can see the before and after imagery from the event.  

Feel free to examine other areas of interest to see what imagery is available and how much the  

land has changed. 

 

 

 

 

 

 

 

Figure 4 
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Step 2: Creating a Placemark 
Placemarks have a variety of uses in Google Earth but are essentially used to represent 

Points of Interest you can refer to. Attributes such as address, accommodations, continental 

breakfast hours, video tours, floor plans, photos, etc. 

 

A) After searching ‘Madison Square Park’, click the Add Placemark button in the toolbar 

(yellow push pin button). This will open the New Placemark window. In the Name 

field, type “Madison Square Park” and leave the other options as their defaults (Figure 

6). Drag the pin to position the place mark between the two fountains, then click OK 

to create your new Placemark. 

 

 

 

 

 

Figure 5 
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B) Now we will be describing the Placemark, which can be done through right clicking 

the Placemark and choosing Properties. In the Edit Placemark window, click inside the 

description box and type anything you wish about the location (Figure 7). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

C) The last step is adding your own photo, which can be done through clicking on Add -> 

Photo (Figure 8). The New Photo Overlay window opens (Figure 9), where you can 

enter the photo name (“Madison Square Park”) and make any necessary adjustments. 

Browse to the photo you would like to use and keep the default settings. 

Figure 6 

Figure 7 
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Figure 10 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*** At this point, make sure to check that all your files are under the ‘My Tour’ folder that was 

created earlier (located under the Places module). So far, the folder should include, the 

Placemark and your own image (Figure 10). 

 

 

 
                                                                                                            
 
 
 
 
 
 

Figure 8 Figure 9 
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Step 3: Adding CSV Data 
 

Before proceeding to create a walking tour, you will need to create and describe two 
more Placemarks for Empire State Building and Madison Square Garden. To add these two 
placemarks, we are going to do what is referred to as Geocoding. This is the process of 
converting tabular data containing street addresses into georeferenced point locational data that 
can be easily mapped. 

 
A) Drag and drop the file Addresses_NY.csv from the tutorial package into Google Earth 

Pro. The Data Import Wizard window opens. If you are repeating the process of 
adding markers without Lat/Long then just apply    a style template. 

 

B) Click Next on the first screen (Figure 11) and ensure that the second screen has the 
option “This dataset does not contain latitude/longitude information, but street 
addresses” checked off (Figure 12). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

C) Set the fields as: City field = CITY, State field = STATE, Zip/postal code = ZIP CODE, and 
Country field = COUNTRY. Then click Finish (Figure 13). 

 
 

Figure 11 Figure 12 
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D) When Google Earth asks you if you wish to apply a Style template, click Yes. Set the 
name field to be “NAME_” on the Name tab and choose the colour and icon style that 
you want, and then click OK (Figure 14). Now it will ask you to save that file that was 
just created, put it      in a folder. 

 
E) Click and drag the .csv file that has been created into the ‘My Tour’ folder to ensure 

that they get saved into the My Places folder. Add information as we did in the 
Madison Square Park steps. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
                                                                                                                                         
      
 
 
 
 
 
 
 

Step 4: Creating a Walking Tour 
 

The direction tool can be used to navigate from one position quickly and efficiently to 
another by car, bike, walking or public transit. The objective here is to use the tool to create a  
walking route connecting all three Placemarks. 

 

A) Begin by creating a walking path connecting Madison Square Park to the Empire State 
Building. To draw the route, you will need to right-click the ‘Madison Square Park’ 
Placemark and select Directions from here (Figure 15). This makes it your starting 

Figure 13 Figure 14 
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point. Now right-click ‘The Empire State Building’ Placemark and make it your 
destination by selecting Directions to here (Figure 16). 

 
 

                                                Figure 15                                                       Figure 16 
  

 

You now see the route Google Earth has plotted from A to B. Normally, the default is for 

walking. Since this is a walking tour, you don’t need to change the method of transit. However, 

since Google Earth suggests the route that uses the least amount of time, the default is 

sometimes public transit. In this case, you can change the method of transit to walking by 

clicking on the appropriate icon (Figure 17-18). You will notice the transit route along using 

streets will be changed to a walking route using sidewalks. 
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Figure 17 Figure 18 
 

B) Next you will need to save the route to “My Places”. Underneath the directions in the 

side panel, click the  icon to save the route to My Places. Once the folder is saved, 

you will notice three sub items under the folder that you just saved. Remove       and 

and any other folders that aren’t named ‘5th Ave’ by pressing Ctrl while selecting 

those items. Afterwards, right-click any of the selected items and select Delete 

(Figure 19). At the end, you should only have one sub folder named “5th Ave” left 

under the main folder for the walking tour. Afterwards, drag the sub folder into the 

folder you created (My Tour) and rename the sub folder to “Madison Square Park to 

Empire State” (Figure 20). 

 

                                  Figure 19                                                                Figure 20 
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C) You can expand the folder and uncheck the intermediate pushpins telling you to turn  

if you wish. Repeat these steps to create a new walking route from The Empire State  

Building to Madison Square Garden. The final walking route (the two walking routes 

you just created combined) should look something like Figure 21 below. You can 

change the color of the route by opening the properties of the Route object in the 

folder subtree. 
 
 

 

 

 

 

 

 
 

 

 

 
 

 

 
 

 
 

 
 

 
 

 

 

 

 
 

                Figure 21 
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Step 5: Creating a Narrative and Animated Tour 

At this stage, you will create and record a tour that navigates your route in Google Earth’s 3D 

environment. You can also add audio commentary to your tour. 

A) To start, Click the Madison Placemark, which will be the starting point for the tour. In the  

Layers panel, turn on the Photos and 3D Buildings layers (Figure 22). Then click the Record 

a Tour button in the toolbar or select Tour from the Add menu. The tour recording 

tools appear in the lower-left corner of the window (Figure 23). 

Figure 22    Figure 23 

 

B) Click the Record button to start recording your actions and movements in Google Earth. 

The button changes to red and the time counter begins counting, showing the 

duration of your current tour. You will notice there is a 3D building for the Eleven Madison 

Park in the 3D viewer (Figure 24). Use the Navigation Controls in the top right corner and 

your mouse to move, tilt, rotate the globe and zoom in around the area (Figure 25). 
 
 
 

Figure 24 Figure 25 
 

C) Once the 360-degree view of the Madison Square Park is finished, you can press the stop 
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recording button. Tour Player appears in the bottom-left corner of the 3D viewer (Figure 

26-27). You can play the tour after the recording is done. 

 

 
 

              

 
 
 
 

 
                                        
                                        Figure 26                                                                    Figure  27 

 

D) To save the tour, click the Save to File button in the Tour Player, and give it a name. The 

new KML file will be saved in “My Places”. Drag it into the “My Tour” Folder. 

 

 

 

 

 

Step 6: Re-record a Tour to Add New Actions 

You can modify and extend a previous tour by re- recording a new tour while playing back 
the original tour. The new tour will add a new action to move around the routes you created in 
Step 4. You are also going to create a 360-degree pan around the two museums. 

 
A) To add a new action into the existing tour, click the Record a Tour button as 

demonstrated in Step 5A. 
 

B) Next, click the Record/Stop button (Figure 23) to start recording a new tour, then play the 
tour that you just  created by double clicking it in ‘My Places’. Wait until the original tour 
finishes playing back. 

 

C) Since you are still recording, you can continue to add new actions. Click the ‘Madison Square 
Park to the Empire State Building’ route file in the ‘My Places’ panel and then click ‘Play Tour’ 
button as seen in Figure 26-27. This allows you to add a tour along a route. Repeat the same 
procedure to play a tour along the two-museum route. 

 
D) Next, double click the ‘Empire State Building and Madison Square Garden’ route file in the 

‘My Places’ panel and switch to Google Street View mode by dragging  to place it at either 

one of the two locations.  On the Navigation Controls in the top right corner (Figure 25), and 
using your mouse to pan, create a 360-degree pan view of the area. 
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E) Once this is done, you can press the stop recording button and click the Save tour button in 
the Tour Player (Figure 26) and give the new tour a name (e.g. “Walking tour new”). What 
many students have done in the past is add text like ‘PAUSE HERE’ for the user to pause the 
video and click on  certain icons themselves. Others have created multiple tours which makes 
creating them more manageable. 

 

 

 

Step 7: Recording Audio Commentary 

Once the tour has been created, you can add an audio recording. Adding an audio clip in this 

way is easy. You must have a microphone linked to your computer. 

 

A) First you will play the tour recording again as demonstrated in Step 6 to figure out how long 

each segment of the tour takes. A segment could be a 360-degree view of the Flat Iron 

Building 

 

B) Write a script exactly for what you will say in the time that each segment takes, for instance 

“We are now walking around the location of the Madison Square Park…”. Test your 

comments to see they fit the time slot. 

 

C) Now click on Record a Tour button as demonstrated in Step 5. Click the microphone 

button  instead of the record button. Click on Record/Stop button (Figure 23) to stop 
recording audio when you finish. 

 
D) Once you’re finished, click the Save tour button in the Record Tour Controls (Figure 26) to 

save the tour. A pop-up window will show up after you click on the Save tour button. 

Enter a meaningful name for your walking tour and click OK (Figure 28). The saved walking 

tour will appear under ‘My places’. Audio recorded through your microphone is captured 

as an .mp3 file when you save the entire folder under ‘My Places’ as a KMZ file. 
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  Figure 28 
 
 
 
 

  
 

 

 

Step 9: Add a Legend or Screen Overlay 

You will learn how to add a legend/logo on the Google Earth screen by creating an image 

file and a simple screen overlay KML file. 

 

A) First you will need to find a computer program which can be used to create drawings on 

either a blank drawing area or an existing image (e.g. Microsoft Paint). Once completed, 

you will save the image file as either JPEG or PNG format to your computer. 

 

B) Next you will need to create a simple screen overlay KML file as shown below. Please 

save your KML file and your photo into the same folder. 
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a. <?xml version="1.0" encoding="UTF-8"?> 

<kml xmlns="http://www.opengis.net/kml/2.2"> 

<ScreenOverlay> 

<name>Absolute Positioning: Top left</name> 

<visibility>1</visibility> 

<Icon> 

<href> AddYourImage.jpg </href> 

</Icon> 

<overlayXY x="0" y="1" xunits="fraction" yunits="fraction"/> 

<screenXY x="0" y="1" xunits="fraction" yunits="fraction"/> 

<rotationXY x="0" y="0" xunits="fraction" yunits="fraction"/> 

<size x="0" y="0" xunits="fraction" yunits="fraction"/> 

</ScreenOverlay> 

</kml> 

 

b.  This Placemark KML file contains the following key elements: 

 

➢ <name> this is used as the label for the Placemark 

➢ <Icon> icon that appears in the screen overlay. 

➢ overlayXY and screenXY controls the location of the legend on the screen 

➢ Specifies the size of the image for the screen overlay 

 

More explanation on how to create a screen overlay KML file can be found through the link 
below: 

https://www.google.com/earth/outreach/learn/adding-legends-logos-and-banners-to-google-earth-
with- screen-overlays/ 

 

Note: To save the code above in Notepad, click File -> Save As… (Figure 29). Enter an appropriate 
name for the KML file and remember to add .kml extension after the file name and select All 
Files for the “Save as type:” field and click Save (Figure 30). 

 

 

 

 

 

 

 

http://www.opengis.net/kml/2.2
http://www.opengis.net/kml/2.2
https://www.google.com/earth/outreach/learn/adding-legends-logos-and-banners-to-google-earth-with-%20screen-overlays/
https://www.google.com/earth/outreach/learn/adding-legends-logos-and-banners-to-google-earth-with-%20screen-overlays/
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Figure 29 
 

 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
                                                                                  Figure 30 
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OPTIONAL: Measurements 

In Google Earth Pro, you get a few more options for finding information about an area,  

including the Measurement tool. In the standard release of Google Earth, only linear measurements 

are allowed. In Pro, you can find out the area by drawing a polygon, either a square or free-form. 

Also, you can measure the height or vertical cross-sectional area of any buildings by drawing a 3D 

path or a 3D polygon. To use the Measure tool, click the ruler button in the toolbar.                                                                     

 

 

 

 

Step 10: Saving 
You may want to add a title for this walking tour. The easiest way to add a title is to create a 

Placemark, then remove its icon. 

 

A) Click the Add Placemark button (yellow push pin button in the toolbar). Drag the new 
Placemark so that it points approximately at the route you just added. 

 

B) Enter a descriptive title for the map (i.e “A Short Walking Tour of Three Academic 

Institutes”). Click the Icon button, just to the right of the Name field. At the bottom of the  

new dialogue box, click No Icon to remove it from view (Figure 31).  

 

C) Right click on the walking trip folder in ‘My Places’ and select ‘Save Place As’ to create a 

KMZ file, which contains all information in the folder and can be shared with others via e- 

mail, Facebook, or Twitter. Whoever receives the file will see exactly what you see when 

opening it up in Google Earth. 

 

If you would like to save an image of your area, follow these steps: 

 

1) Go to File -> Save, and on the menu that expands, click Save Image… 

 

2) A toolbar on the top of the main viewing window appears (Figure 32), as well as a legend 

and map title. The toolbar controls everything that exports out into the image and the 

image exporting itself. 

 

3) If you want to get rid of the legend and other map elements, click on Map Options in the 

new toolbar and uncheck all the elements. If you want to get rid of the icons on the map 

and only leave the imagery, then uncheck the undesired layer in the Layers pane at the 
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bottom left of the main window. 

 

4) Adjust the resolution in the new toolbar to your liking and specifications. If you are unsure  

about your desired resolution, leave it as default. 

 

5) When you are satisfied with how your image will come out, click the Save Image… button 

on the toolbar. Select your destination and name. Your creation will export as a .jpg image. 

 

 

 
 

                              
 

 
 

 
 
 
 

 
 
 
 

 
                                                         Figure 31                                                                             Figure 32 
         
 
 
 

 

 

OPTIONAL: Explore Google Earth on the Web 

You don’t need to install Google Earth Pro to use what you’ve learned in this tutorial; Google  
Earth is now on your browser! Access it from https://earth.google.com/web and explore the places 
you love with a lot of new features. 

 

• Explore new tours and guides created by users and curated by editors. 

 

• Make your own project and save it directly onto your Google Drive. You can make 
presentations out of your tours now and tell your audience a real story! 

https://earth.google.com/web


22 
 

 

• Use the Voyager feature to see tours, quizzes, and guides that stand out and can help 

inspire you on your mapping journey. 
 

• Make places and features, then export directly as KML just from your browser.   
 
 
 

To learn more about Google Earth online, this appendix will walk you through making a 
presentation of select areas. 
 

1) Go to https://earth.google.com/web. 
 

2) Click the  button at the top left of the screen and log into/register a new Google 
account. Note that if you do not want to use a Google account, it is possible to 
export your results as KML. 

 

3) In the same menu, click on Projects -> New Project -> Create project in Google Drive 
to create a new project. It will be saved in your Google Drive. 

 
4) Click on Untitled Project to give your new project a name and description. This will be 

saved and help organize it within your Google Drive. 
 

5) You are going to make a presentation about some sites on UW Campus. To start, click on 
New Feature and then click Search to Add Place. Look up “University of Waterloo” and 
click the appropriate result. The Earth will zoom to campus. Click Add to Project on the 
right pane to add this view to your presentation. Click on the back       button on the 
upper left of the window when the place is added to your project. 
 

6) Give some context to your presentation by adding a Fullscreen Slide to it (New feature -> 
Fullscreen Slide). Edit the slide’s color and text so that it is visually appealing and informs  
the audience of what they are looking at and should pay attention to. When you finish, 
click on the back button to return to the previous menu.  

 
7) Draw attention to a certain point using a Placemark. Drop your placemark on the ground or 

on the 3D model (New feature -> Add Placemark) and edit the name and description. 
Choose from a selection of custom placemarks to draw attention to your point. If you have 
some pictures or videos of the point on the placemark, you can add them on the left pane 
so that it pops up! 

 
8) Add in some paths and shapes to show some boundaries and areas of interest to your 

viewers. You can customize the colour and width of your lines to draw your viewers’ 
attention to a central feature. Try drawing the path you take to get to class using the line 

https://earth.google.com/web
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tool (New feature -> Draw line or shape), and draw a shape representing the building 
that your class is in. 

 
9) Keep adding in slides, paths, and placemarks until your presentation is complete. Make 

your descriptions useful since they will pop up during the presentation. Use photos to add 
more detail about locations and to liven up your presentation. 

 
10) When finished, your project autosaves to your Google drive, but you can also export the 

project to KML using the       button at the top of the projects pane. 
 

11) Click the Present button when you want to start presenting. If you want to share the 
presentation with someone else, copy the link from your Google Drive and send it  to the 
other person. 

 
 
 
 
 
 

OPTIONAL: Edit the KML of a Layer You Made to Make a Time Animation 

One of the most important things you need to know about Google Earth Pro is that most of 
the features that let you make a customized layer and specific use-case is not given in the Google 
Earth Pro GUI, but rather in the KML that underlies the features. KML stands for Keyhole Markup 
Language and is the language that tells the program how, where, and when to display a feature 
on the map. You are going to explore this functionality by making a series of placemarks that 
fade into  view as an animation over time. This feature is generally reserved for points made by a 
GPS, but using KML, you can do the same presentation of the data with just your computer. You 
can find all the documentation that you might need about KML (and specifically about the time 
attributes that you will be using) on the documentation website:  

 

https://developers.google.com/kml/documentation/time#time-stamps-and-gps-data 

 
1) Make a series of placemarks. Arrange them so that the progression over time would look 

natural and easy for the viewer to follow. 
 

2) Add a folder in the Places pane and move all of your placemarks into that folder. 
 

3) Right-click your folder and click Save Place As…, then save the file to a place you can easily 
remember. Make sure to switch the file type to KML, not KMZ. 

 

4) Find the place you saved your KML and open it in a text editor such as Notepad. For this 
tutorial, it is recommended you use one with HTML/XML/KML tag highlighting, like 

https://developers.google.com/kml/documentation/time#time-stamps-and-gps-data


24 
 

Notepad++ (though  this feature is optional). 

 

5) Find a <Placemark> tag inside of your KML file and identify which one the placemark you 
found is (use a name you gave it, for example). In between the <Placemark> and 
</Placemark> tags, put a <TimeStamp> and </TimeStamp> tag. Make sure these two tags 
are next to each other. In-between these two tags, put <when> and </when>. 
 

a. Like most markup languages, KML uses tags to define elements. Elements start with 
a beginning tag (denoted by <, followed by the name, and then >) and an ending tag 
(denoted by </, the same name as the beginning tag, then >). Other tags and 
elements can go in-between beginning and end tags (as evident by the fact that 
inside your KML file, your <Placemark> element has many elements and tags in- 
between its tags), but they must have beginning and end tags. There are exceptions 
to this rule that you can learn more about in the abundant HTML tutorials that are 
found online. 
 

b. There is another element type for time inside KML known as <TimeSpan>. Timespan 
uses a <begin> element and <end> element and defines a range of time for which 
the feature would be displayed. This is to be contrasted with <TimeStamp> which 
starts appearing at the specified time. Consult the documentation at the link above 
for more information and examples on using <TimeSpan>. If you suspect that an 
example KML file in the link above is broken, right-click on it and Save Link As… onto 
your computer. 

 
6) Define a time for your timestamp by putting it in between the when tags. Time and date is 

to be formatted in XML schema time, which is yyyy-mm-dd. You can leave out time 
elements that you don’t need (for example, the format stated in this step excludes time 
altogether and only keeps date – yet is a completely valid XML schema time statement. If 
you wanted to add time to it, the schema is yyyy-mm-ddThh:mm:ssZ, where T is a constant 
(it only denotes that time is being stated) and Z is a constant (used to tell the program that 
Universal Coordinated Time is being used). See the documentation at the link above to 
learn more about XML schema time. 
 

7) Repeat these steps for the rest of your placemarks. Stagger your timestamps so that some 
appear after others. Remember that with timestamps, placemarks that have appeared do 
not disappear since they do not have an end time. If you want your placemark to disappear 
after a while, use a timespan. 
 

8) Once you’ve finished adding timestamps, and you are sure there are no errors in your 
markup, save your code. The steps for saving your code in a text editor is 
demonstrated in the note section of Step 9B of the tutorial. Move your KML back into 
Google Earth Pro. 

 
9) You will notice that a new time slider appears when your layer is added. Move the right 

https://notepad-plus-plus.org/
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bound of the slider all the way to the left. Press the time animation button to start playing 
your animation and watch your layer play through time. 

 
An example of a time animation playthrough, which is the KML that this tutorial comes with, below. 
 

 

 

 

                                                                                                                                  
                                                                             Figure 33 – Time Animation of Three Points 
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